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This book, the VMware vCenter AppSpeed Installation and Upgrade Guide, describes the procedures for installing 
the VMware vCenter AppSpeed™ virtual appliance and plug-in, including how to configure the AppSpeed 
Server and how to deploy the AppSpeed probes on the VMware host machines within the datacenter network.

Intended Audience
This guide is intended for anyone who wants to install the AppSpeed virtual appliance and plug-in on a 
vSphere™ Server. The vSphere Server is an upgrade from vCenter Server 2.5. All the procedures described in 
this guide are also relevant when AppSpeed is being installed on a vCenter Server, however some of the user 
interface terminology and locations of user interface components might differ.

The information is written for experienced Windows or Linux system administrators who are familiar with 
virtual appliance technology and datacenter operations.

Document Feedback
VMware welcomes your suggestions for improving our documentation. If you have comments, send your 
feedback to docfeedback@vmware.com.

Technical Support and Education Resources
The following sections describe the technical support resources available to you. To access the current versions 
of this book and other books, go to http://www.vmware.com/support/pubs.

Online and Telephone Support

Use online support to submit technical support requests, view your product and contract information, and 
register your products. Go to http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the fastest response on 
priority 1 issues. Go to http://www.vmware.com/support/phone_support.

Support Offerings

Find out how VMware support offerings can help meet your business needs. Go to 
http://www.vmware.com/support/services.

VMware Professional Services

VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials 
designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live 
online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides 
offerings to help you assess, plan, build, and manage your virtual environment. To access information about 
education classes, certification programs, and consulting services, go to http://www.vmware.com/services/. 

About This Book

mailto:docfeedback@vmware.com
http://www.vmware.com/support/pubs
http://www.vmware.com/support
http://www.vmware.com/support/phone_support.html
http://www.vmware.com/support/services
http://www.vmware.com/services/


VMware vCenter AppSpeed Installation and Upgrade Guide

6 VMware, Inc.



VMware, Inc. 7

AppSpeed Installation Overview
VMware vCenter AppSpeed provides performance management and service-level reporting for applications 
running within virtual appliances. AppSpeed analyzes the traffic that flows between end users, Web 
applications, and back-end servers. This analysis provides visibility into multitier applications. The analysis 
enables rapid identification of performance problems that originate from inadequate resource allocation and 
application problems.

AppSpeed is installed on a VMware host machine that resides within the data center network and integrates 
with the VMware vSphere™ Client. AppSpeed is installed on a centralized server, with one or more AppSpeed 
probes installed on each host to be monitored.

This chapter includes the following topics:

 “Installation Workflow” on page 7

 “Installation Prerequisites” on page 8

 “Installing and Configuring AppSpeed Server” on page 9

 “Installing the AppSpeed Plug-In and Probes” on page 11

 “Multiple AppSpeed Servers” on page 22

 “Upgrading AppSpeed” on page 24

 “Extracting SSL Files” on page 23

 “Uninstalling AppSpeed and Removing the AppSpeed Plug-In” on page 25

 “Troubleshooting” on page 26

Installation Workflow
AppSpeed is a virtual appliance in Open Virtualization Format (OVF). The AppSpeed plug-in is installed in 
the vSphere Client.

You perform the installation and setup process in the following stages: 

 Import the OVF file and configure AppSpeed Server (see “Installing and Configuring AppSpeed Server” 
on page 9)

 Install the AppSpeed plug-in in the Client (see “Install the AppSpeed Plug-In” on page 11)

 Add a valid AppSpeed license key (see “Add a License” on page 13)

 Install the AppSpeed probes by using the AppSpeed user interface in the Client (see “Deploy the 
AppSpeed Probes” on page 13)

 Verify the successful deployment of the probes (see “Verify the Installation” on page 15)

To upgrade to the most recent version of AppSpeed, see “Upgrading AppSpeed” on page 24.

VMware vCenter AppSpeed Installation
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Installation Prerequisites
The following VMware ESX™ and vCenter versions support AppSpeed:

 ESX, version 3.0.x, 3.5.x, or 4.0x

 vCenter Server, version 2.5x, or vSphere 4.0

System Requirements

Review the following system requirements before you install AppSpeed:

 You must have admin-level access to vCenter Server for the automated installation process.

 You must define routable IP addresses for servers and probes.

VMware recommends that you do not use DHCP because the IP address of AppSpeed Server might 
change after setup is complete. However, if you do use DHCP, you do not need routable IP addresses.

 If HTTPS sites are to be monitored, you require the SSL private keys.

 You must have Administrator privileges on the Client machine to install Adobe Flash Player 10.

 VMware recommends that you synchronize the time on the hosts on which AppSpeed Server and the 
AppSpeed probes will be installed. If the time is not synchronized, AppSpeed might lose data and 
experience delays in the mapping process. You can synchronize the time by setting an NTP server in the 
Configuring Time option for each ESX host in vCenter.

Deployment Considerations

When you plan your AppSpeed deployment, consider the following system resource requirements:

 Server

 30GB HDD

 4GB RAM

 2 vCPUs

Virtual CPUs are created as part of the AppSpeed deployment. Two vCPUs require no more than the 
equivalent resources of a single physical CPU.

 Probes

 5GB HDD

 0.5GB RAM

 2 vCPUs

Virtual CPUs are created as part of the AppSpeed deployment. Two vCPUs require no more than the 
equivalent resources of a single physical CPU. AppSpeed configures resource limits to ensure that no 
more resources than are available on the physical CPU are required at any time.
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Open Port Requirements

AppSpeed requires that the following ports be open on your firewall:.

Installing and Configuring AppSpeed Server
You can install AppSpeed Server on any ESX host that is managed by vCenter Server for the environment you 
want to monitor. AppSpeed is provided as an OVF file. 

Import the OVF File to the vSphere Client

The first step in the installation process is to import the OVF file in the installation package to the 
vSphere Client. You must have administrator privileges to import the OVF file. 

Procedure

1 Save the OVF file in the same location as the other files in the installation package, which must be a 
location that you can access from the vSphere Client.

2 In the vSphere Client, select File > Deploy OVF Template.

3 Select Deploy from File and click Browse to locate the OVF file.

4 Click Next and click Next again.

5 Read and accept the End User License Agreement, and click Next.

6 Type a name for the virtual appliance server in the Name text box. 

The name must be unique in the vSphere Client. 

Table 1.  Open Port Requirements

Server Connection Required Open Ports

AppSpeed Server to vCenter Server

TCP port 443 to connect to vCenter Server for the vCenter 
interface. 
Port 443 is the vCenter default Web service port, but you can 
configure a different TCP port in vCenter.

TCP port 80 to connect to vCenter Server for the vCenter proxy 
interface. 
This port is used only during setup to verify that the vCenter 
proxy is configured correctly. 
Port 80 is the vCenter default proxy service port, but you can 
configure a different TCP port in vCenter.

vCenter Server to AppSpeed Server

TCP port 80 to connect to AppSpeed Server (Web interface).

AppSpeed Server and probe communication

TCP port 1194 to connect to AppSpeed Server (OpenVPN over a 
TCP connection).

UDP port 123 to connect to AppSpeed Server (NTP).

TCP port 22 to connect to the probes if you want to access the 
probes from outside the VPN.

vSphere to vCenter Server

TCP port 80 to connect to vCenter Server (vCenter proxy 
interface). 
Port 80 is the vCenter default proxy service port, but you can 
configure a different TCP port in vCenter.
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7 Select the location for the deployed template and click Next.

8 From the Host/Cluster tree in the upper-right pane, select the ESX host on which to install the virtual 
appliance, and click Next.

The host must be managed by vCenter Server for the environment that you want to monitor. 

If you select a cluster, you might be required to select a specific host in that cluster.

9 (Optional) Select the datastore on which to store the files for the virtual appliance, and click Next.

10 From the Management Network menu, select a network that has access to the other machines and to 
vCenter Server to use to manage the probes. 

AppSpeed Server uses this network to deploy and communicate with probes deployed on other hosts. 

11 Click Next.

12 Review the installation summary and click Finish to begin installation. 

When the installation is complete, the virtual appliance is added in the vSphere Client. 

13 In the vSphere Client, select File > Inventory > Files and Clusters, and in the Basic Tasks pane click Power 
on the virtual appliance to start the virtual appliance.

Configure AppSpeed Server

You configure AppSpeed Server from the vSphere Client. The first time you access the console you are 
prompted to configure AppSpeed Server.

As part of the configuration process, AppSpeed performs the following actions in vCenter:

 Creates a snapshot of the AppSpeed Server virtual machine

 Registers the AppSpeed plug-in as a vCenter Client extension

 Registers the redirection of AppSpeed in the vCenter proxy

 Registers AppSpeed Server to start automatically when a host starts up

 Registers the AppSpeed Server power-off settings so that AppSpeed is properly shut down when 
powering off

 Adds an AppSpeed User role and AppSpeed User privileges that enable access, view and management 
privileges for the AppSpeed plug-in to be assigned to users

 Reserves CPU allocation to optimize AppSpeed performance

Procedure

1 Power on the server virtual appliance and open the AppSpeed Server console.

When the virtual appliance starts, the console is displayed.

2 At the login prompt, type setup.

3 (Optional) If you need to exit the console after you begin the setup, press Ctrl+C to exit the setup, and 
press Ctrl+C again to reinitiate the setup.

4 Press Enter to accept the default value, or specify an alternative value.

The default, or previously defined, value for each parameter appears in brackets.

5 (Optional) Select a setting for the network management card.

a Type Y to use DHCP settings.

b Type N to set a fixed IP address. 

You are prompted to set the IP address, netmask, and gateway for the management card.

c (Optional) If you do not want to specify the gateway, type 0.0.0.0. 
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6 Set the AppSpeed time zone.

If the time zone list does not fit in the console window, press Shift+Page Up/Page Down to view all 
locations.

7 Configure the vCenter IP address, user name, and password when prompted.

8 (Optional) Specify the port number. 

Type the port number immediately after the IP address, preceded by a colon (:). For example, 
10.23.89.89:8080 indicates port 8080 on IP address 10.23.89.89.

9 Set a unique namespace for this AppSpeed Server.

The namespace can consist of up to 26 lowercase letters, digits, and dashes. 

The namespace is required for user interface connections.

10 Press Enter to confirm that you want to complete the setup process. 

11 (Optional) Press Ctrl+C to reinitiate the setup process and change any parameter values. 

If you reinitiate the setup process, the previous values are retained. You can change the values as needed.

12 When prompted, review the setup summary and type Y to accept the settings and complete the setup 
process.

You can install more than one AppSpeed Server. For further information, see “Multiple AppSpeed Servers” on 
page 22. When you complete the AppSpeed Server configuration, install the AppSpeed plug-in and probes.

Installing the AppSpeed Plug-In and Probes
Before you can take advantage of the monitoring capabilities of AppSpeed, you must install the AppSpeed 
plug-in and deploy the AppSpeed probes. You must have vSphere Admin or AppSpeed User privileges to 
access the AppSpeed plug-in.

Install the AppSpeed Plug-In

You must install the AppSpeed plug-in on each vSphere Client that needs to connect to AppSpeed.

Procedure

1 In the vSphere Client, select Plug-ins > Manage Plug-ins.

2 Select the appropriate AppSpeed plug-in from the Available Plug-ins list and click the Download and 
install link.

A progress window indicates the progress until the installation is complete.

3 Ensure that the vSphere Client is closed and click Close when the installation is complete.

4 Reopen the vSphere Client and right-click the AppSpeed plug-in to ensure that it is Enabled. 

The AppSpeed icon is added to the Solutions & Applications tab on the Home page.

Configure an AppSpeed Plug-In to Directly Access an AppSpeed Server

You can configure an AppSpeed plug-in to connect directly to an AppSpeed Server. You must repeat this 
process for each client machine.

Procedure

1 From the Plugins folder, located in the Virtual Infrastructure Client folder on the vSphere Client 
machine, open the AppSpeed folder.

2 Locate the settings.config file and open it in a text editor.

3 Change the <Protocol> parameter to https.
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4 Change the <UseProxy> parameter to False.

Setting False for this parameter obligates direct access from the client machine to the AppSpeed Server.

5 Save and close the settings.config file and restart vSphere to apply the changes.

6 Connect to AppSpeed Server.

A security warning, related to the address of AppSpeed Server, appears.

7 In the Security Warning dialog box, click View Certificate, and click Install Certificate in the Certificate 
dialog box.

8 Follow the instructions in the Certificate Import wizard.

 If you have a Windows XP machine, you can either accept the wizard defaults or you can specify the 
parameters required for Windows Vista and Windows 7 machines.

 If you have a Windows Vista or Windows 7 machine, select the Place all certificates in the following 
store option and select Trusted Root Certification Authorities, then click OK.

9 Click Finish.

10 Click Yes in response to the question Do you want to install this certificate? and at the confirmation 
prompt, click OK.

11 Click Ignore at the security prompt.

The AppSpeed user interface opens.

Configure Access to AppSpeed Server Through a Proxy

If direct access from the client machine to AppSpeed Server is not applicable, you need to configure AppSpeed 
to use a proxy.

Procedure

1 Open the AppSpeed Server console.

2 At the prompt, type direct_connection_info and configure AppSpeed to use a proxy.

Remove Direct Access to AppSpeed Server

If direct access from the client machine to AppSpeed Server is not applicable, you can use vSphere Server as a 
proxy.

Procedure

1 From the Plugins folder, located in the Virtual Infrastructure Client folder on the vSphere Client 
machine, open the AppSpeed folder.

2 Locate the settings.config file and open it in a text editor.

3 Change the <Protocol> parameter to http.

4 Change the <UseProxy> parameter to True.

Setting True for this parameter removes the obligation for direct access from the client machine to 
AppSpeed Server.

5 Save and close the settings.config file.

6 Restart vSphere to apply the changes.

Define AppSpeed Users

Only users who are assigned the AppSpeed User role or AppSpeed user privileges on the AppSpeed Server 
virtual machine can access, view, or manage AppSpeed. AppSpeed privileges are automatically added to the 
Administrator role during AppSpeed Server setup. You can also add AppSpeed privileges to other existing 
roles.
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Procedure

1 In the vSphere Client, right-click the appropriate AppSpeed Server in the Inventory tree.

2 Select Add Permission.

3 In the Assign Permissions window, click Add to select and add a user or group of users to the Users and 
Groups pane.

4 Select AppSpeed User in the list in the Assigned Role pane.

5 Click OK.

Add a License

You must have an AppSpeed license to monitor servers. You can deploy up to eight probes if you are using an 
evaluation license.

Procedure

1 Click the Administration tab, and in the Management Tools pane click Licensing. 

2 Click Add License.

3 Type the license key provided by VMware in the text box and click OK.

The license key is validated and its details are added in the License page. 

Deploy the AppSpeed Probes

Before the monitoring process can begin, you must install at least one AppSpeed probe on one or more hosts. 
Each probe can monitor up to three vSwitches. You can install more than one probe on the same host to 
monitor additional vSwitches. The probe settings, including the management network, storage device, and 
monitored vSwitches, are configured as part of the probe installation process. 

You can add and remove probes. See “Install an AppSpeed Probe” on page 14 and “Delete Probes from Hosts” 
on page 15. 

To modify the probe configuration, see the VMware vCenter AppSpeed User’s Guide.

To configure the AppSpeed probe to monitor a vNetwork distributed switch, see “Configure AppSpeed with 
vNetwork Distributed Switching” on page 17.

The AppSpeed probe deployment process automatically makes the following changes in the vCenter:

 Creates a snapshot of the AppSpeed Server virtual machine if one does not already exist. To save disk 
space, you can remove the AppSpeed Server virtual machine snapshots after the probe installation is 
complete.

 Creates the AppSpeed Probes folder if it does not already exist.

 Creates promiscuous port groups for the selected vSwitches. 

 Creates a probe by creating a linked clone of AppSpeed Server. AppSpeed Server is cloned as the probe, 
then the linked clone is deleted. If the linked clone cannot be created, AppSpeed creates a new virtual 
machine and copies it. The virtual machine of the probe has the appropriate hardware settings, including 
CPU and memory reservation. 

 Reconfigures the probe's cluster so that the probe is not subject to VMware Distributed Resource Scheduler 
(DRS) and VMware High Availability (HA), ensuring that the probes remain on the host on which they 
were deployed.

 Powers on the probe. 

 Edits and reconfigures the probe's settings.
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Install an AppSpeed Probe

You can install a probe on one host at a time, or you can install a probe on multiple hosts at the same time. You 
can also install more than one probe on the same host. 

When you install a probe in AppSpeed, distributed vSwitches do not appear in the Probe Installation window. 
To monitor these switches, you must configure the AppSpeed probe. See “Configure AppSpeed with 
vNetwork Distributed Switching” on page 17.

Procedure

1 Click Home > Solutions and Applications and click the AppSpeed icon.

2 (Optional) If the AppSpeed icon does not appear, verify that the AppSpeed plug-in is enabled in the 
Plug-ins menu.

3 Click the Administration tab and select Probes Management.

4 Select the check boxes for one or more hosts or clusters on which to install a probe and click the Install 
Probes button.

A probe is installed on each selected host, regardless of whether another probe is already installed on the host.

When you select the check box for a cluster, the check boxes for each host that it contains are selected. 
Similarly, when you select a host, the probes already installed on it are selected.

The Probe Installation window displays a separate entry for each host that you select. Each entry appears 
in a separate pane. 

5 Configure the probe for each probe entry, as described in “Configure the Probe for Each Host Entry” on 
page 14.

6 (Optional) To add another probe to a host, click  Install another probe on this host at the bottom of 
the host entry and configure the probe, as described in “Configure the Probe for Each Host Entry” on 
page 14.

7 When you finish adding host-probe combinations, click the Install Probes button.

8 Review the installation information, and click OK.

Alternatively, click Back to return to change any of the settings.

The installation progress is indicated in the Probe Status column in the Probes Management window.

Upon completion, the new probe is added to the <namespace> Probes folder in the vSphere Client. The 
probe is powered on and set up. 

9 Delete the AppSpeed Server virtual machine snapshot after you finish deploying all the probes.

Configure the Probe for Each Host Entry

Optionally, you can configure the probe for each host entry that is displayed in the Probe Installation window. 
Consider using local storage, which enables faster probe deployment.

The probe also connects to the management network you specified, but it does not monitor the network

Prerequisite

If you have only distributed virtual switches on your host, you must first create a temporary vSwitch, and 
install and deploy a temporary probe.

This means that you must either install a probe to monitor the vSwitch, or install a probe that uses the vSwitch 
as a management NIC.
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Procedure

1 Type the name of the probe in the Probe Name text box. 

If you do not specify a name, AppSpeed Server assigns a default name.

2 From the Storage menu, select the storage device to which the probe connects.

3 From the Management Network menu, select the network to use to manage the probes.

a Select up to three monitoring vSwitches.

The vSwitches sniff traffic on the configured management network. 

By default, the first three available vSwitches are selected.

b Select either the DHCP or Static IP option. 

If you select Static IP, you must type values for each of the IP, Network, and Gateway (optional) 
fields.

4 Click Install Probes.

5 Review the summary and click OK.

The probe is installed.

Power Probes On or Off

You can power probes on or off from the Probes Management window.

Procedure

1 Click the Administration tab, and in the Management Tools pane click Probes Management. 

2 In the Probes Management window, select the check boxes for one or more probes, and click Power On 
or Power Off.

Delete Probes from Hosts

If you do not want to monitor the traffic on a specific host, you can remove the probes from that host. If you 
do not want to monitor specific vSwitches on a host, you can delete the probe that is monitoring those switches.

Procedure

1 Click the Administration tab, and in the Management Tools pane click Probes Management.

2 In the Probes Management window, select the check boxes for one or more probes on one or multiple 
hosts, click Delete Probe, and click OK to confirm.

The probe is removed from the selected hosts only.

Verify the Installation

You can verify the successful installation and deployment of the probes by checking the probe status in any of 
the following locations:

 Recent Tasks pane of the vSphere Client

 Probes Management window of the AppSpeed user interface

 Servers tab or Transactions tab of the Unmapped Traffic page 

If the probe is successfully installed and deployed, the status of the probe is Running. In addition, if active traffic 
is present on the part of the network that the probe is monitoring, the traffic throughput is reflected accordingly. 

The traffic throughput can be 0 if there is no traffic on the monitored vSwitches or if a problem occurs with the 
installation. If the problem persists and you know that traffic is present, see “Troubleshooting” on page 26.
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View Unmapped Traffic

You can view information about the unmapped servers and transactions detected on the network. Unmapped 
objects are not yet mapped to a specific server or application. The number of unmapped objects typically 
decreases as AppSpeed maps the environment.

To view unmapped traffic on HTTP sites that incorporate SSL protection, you must configure the SSL keys for 
each endpoint where AppSpeed detects SSL traffic. See “Manage SSL Keys” on page 16.

Procedure

1 In the Inventory tree, select Applications and Servers. 

2 On the page selection bar, click Unmapped Traffic.

3 View the status information for the unmapped traffic.

 Server: Name of the server (Servers tab only).

 Name: Name of transaction (Transactions tab only).

 Endpoint: IP address and ports used by the server (Servers tab only).

 Latency: Average and standard deviation (STDEV) latency rates for the server or transaction. 

 Hits: Average number of hits per second for the server or transaction, and the total number of hits in 
the specified time frame.

 Throughput: Average throughput for the server or transaction, and the total throughput in the 
specified time frame.

 Errors: Average rate of errors, as a percentage, for the server or transaction.

Manage SSL Keys

For AppSpeed to monitor traffic on HTTPS sites that incorporate SSL protection, you must configure the SSL 
keys for each endpoint, the IP address and port pair, where AppSpeed detects SSL traffic. AppSpeed supports 
the configuration and monitoring of SSL keys for HTTPS sites only

View SSL Key Information

You can view the existing SSL key configuration in the AppSpeed user interface. Viewing the key 
configuration will enable you to decide for which endpoints you want to provide an SSL key. 

Procedure

1 Click the Administration tab, and in the Management Tools pane click SSL Management. 

2 View the secure site endpoints for which AppSpeed cannot monitor traffic without a key.

 The Pending SSL Endpoints table lists the endpoints for which valid SSL keys are required, including 
their IP addresses and ports. AppSpeed automatically identifies the SSL endpoints for which keys do 
not exist. 

 The Monitored SSL Endpoints table lists the endpoints for which valid keys exist in AppSpeed, 
including the respective server name, where available, and IP address and ports. AppSpeed monitors 
traffic on these endpoints. 
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Add an SSL Key

You can assign a key to a pending endpoint to enable AppSpeed to actively monitor its traffic.

If necessary, you can extract the SSL files from the Web server to obtain the key (see “Extracting SSL Files” on 
page 23).

Procedure

1 In the SSL Management window, select the check boxes for the endpoints in the SSL Pending Endpoints 
table and click Add/Update SSL key.

2 Browse to and open the key file. 

The key is assigned to the selected endpoints. The endpoint moves from the SSL Pending Endpoints table 
to the Monitored Endpoints table.

Configure AppSpeed with vNetwork Distributed Switching

When you install a probe in AppSpeed the distributed switches do not appear in the Probe Installation 
window. You must manually configure AppSpeed to monitor these switches. AppSpeed can monitor one 
vNetwork Distributed Switch in each distributed virtual port group.

You need to review the following issues before proceeding:

 You must have an existing vSwitch that is not already being monitored by an AppSpeed probe. If you do 
not have an available vSwitch, you must create a temporary one, as described in “Creating and Deploying 
Temporary vSwitches” on page 21.

 Consider whether the management network needs to be connected to the distributed vSwitch, or only to 
the monitoring functionality

 Consider whether the probe needs to be deployed on a distributed vSwitch or on a Cisco Nexus 1000v 
switch.

Use the information in Table 2 to determine which procedures you need to perform.
Table 2.  Configuring vNetwork Distributed Switching: Procedure Decision Table

Goal Process See

Configure AppSpeed to monitor a 
vNetwork distributed switch

 Create a distributed virtual port 
group

 Configure the distributed virtual 
port group

 Configure the probe to monitor 
the vNetwork distributed switch

“Create a Distributed vNetwork Port 
Group” on page 18

“Configure the Distributed Virtual 
Port Group” on page 18
“Configure the AppSpeed Probe to 
Monitor a vNetwork Distributed 
Switch” on page 19

Create a temporary vSwitch (when 
there is no available vSwitch for the 
probe to monitor)

 Create a temporary vSwitch

 Deploy a probe on the temporary 
vSwitch

“Create a Temporary vSwitch” on 
page 21
“Deploy a Probe on a Temporary 
vSwitch” on page 21

Configure AppSpeed to monitor 
Cisco Nexus 1000v switches

 Install a probe

 Configure the probe to monitor 
the Nexus 1000v switch

 Configure port mirroring

“Install a probe on a Cisco Nexus 
1000V Switch” on page 20
“Configure the AppSpeed Probe to 
Monitor a Cisco Nexus 1000V Switch” 
on page 20
“Configure Port Mirroring” on 
page 21
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Configure AppSpeed to Monitor a vNetwork Distributed Switch

This section describes the basic procedures for configuring an AppSpeed probe to monitor a vNetwork 
distributed switch in which the creation of a temporary vSwitch is not required. 

AppSpeed can monitor vNetwork distributed switches. However, AppSpeed does not directly install a probe 
to monitor such a switch. 

As part of the probe installation, you need to specify an available vSwitch to monitor during the installation 
process, until the probe is eventually configured to monitor the distributed vSwitch. You also need to create a 
promiscuous distributed virtual port group, and change the network settings of the probe to monitor the 
vNetwork distributed switch. As with vSwitches, AppSpeed monitors only the virtual machines on hosts on 
which the probes are installed.

To deploy a probe, at least one vSwitch must be available on the host for the probe to monitor. If the host does 
not have any vSwitches configured, or if all other vSwitches are already being monitored by other probes, you 
must create a new temporary vSwitch before you deploy the new probe. Use the procedures described in 
“Creating and Deploying Temporary vSwitches” on page 21.

If you want to configure AppSpeed probes to monitor Cisco Nexus 1000v switches, use the procedures 
described in “Configure AppSpeed to Monitor a vNetwork Distributed Switch” on page 18.

You cannot monitor a vSwitch that is already being monitored by another probe.

Create a Distributed vNetwork Port Group

If you deploy a vNetwork Distributed Switch, add a new port group.

Procedure

1 In the vSphere Client, select Home. On the Inventory tab, select Networking.

2 Create a new port group for the vNetwork Distributed Switch,

a Right-click the vNetwork Distributed Switch and select New Port Group.

b Specify the required parameters in the Create Distributed Virtual Port Group dialog box to create a 
new port group and click Finish.

Configure the Distributed Virtual Port Group

You must configure the vNetwork Distributed Switch ports to work in promiscuous mode so that the 
AppSpeed probe can monitor the switch. 

Procedure

1 In the vSphere Client, select Home. On the Inventory tab, select Networking.

2 Right-click the relevant port group in the vNetwork Distributed Switch and select Edit Settings.

3 Select Security.

4 Set the Promiscuous mode to Accept.

5 Select VLAN. 

6 Set the VLAN type to VLAN Trunking.

7 Set the VLAN trunk range to 0-4094.

8 Click OK.

Deploy an AppSpeed Probe

You can install a probe on one host at a time, or you can install a probe on multiple hosts at the same time.

When you install a probe in AppSpeed, distributed vSwitches do not appear in the Probe Installation window. 
To monitor these switches, you must configure the AppSpeed probe. See “Configure AppSpeed with 
vNetwork Distributed Switching” on page 17.
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Procedure

1 In the vSphere Client, select Home. On the Solutions and Applications tab, click the AppSpeed icon.

2 (Optional) If the name displayed in the Connect to text box is incorrect or the AppSpeed Server name is 
not in the list, type the correct namespace.

3 (Optional) If the AppSpeed icon does not appear, verify that the AppSpeed plug-in is enabled in the 
Plug-ins menu.

4 Click the Administration tab and select Probes Management.

5 Select the check boxes for one or more hosts or clusters on which to install a probe and click the Install 
Probes button.

A probe is installed on each selected host, regardless of whether another probe is already installed on the host.

When you select the check box for a cluster, the check boxes for each host that it contains are selected. 
Similarly, when you select a host, the probes already installed on it are selected.

The Probe Installation window displays a separate entry for each host that you select. Each entry appears 
in a separate pane. 

6 Click the Install Probes button.

7 Review the installation information, and click OK.

Alternatively, click Back to return to change any of the settings.

The installation progress is indicated in the Probe Status column in the Probes Management window.

Upon completion, the new probe is added to the <namespace> Probes folder in the vSphere Client. The 
probe is powered on and set up. 

NOTE   If your management network was set to a temporary vSwitch and the probe failed to communicate 
with AppSpeed Server, an error message appears when the probe deployment completes. The issue is 
resolved when you perform the following steps, however the error message might continue to appear as 
failed in the user interface.

a Right-click the probe name, select Edit Settings and specify the management network and monitor 
network settings as required. For further information, see step 3 in “Configure the AppSpeed Probe 
to Monitor a Cisco Nexus 1000V Switch.”

b Restart the probe by selecting the probe in the Inventory tree, and pressing CTRL+R.

8 Delete the AppSpeed Server virtual machine snapshot after you finish deploying all the probes.

Configure the AppSpeed Probe to Monitor a vNetwork Distributed Switch

After the AppSpeed probe is deployed and set up, you can configure it to monitor a distributed vSwitch.

Procedure

1 In the vSphere Client, select Home. On the Inventory tab, select Hosts and Clusters.

2 In the Inventory tree, right-click the probe to which the probe is connected in the distributed vSwitch and 
select Edit Settings.

3 (Optional) To add the management network to the distributed vSwitch, select Network adapter 1. 

a Under Network Connection, select the Network label option, and select the relevant distributed 
virtual port group, by default, dvPortgroupX.

b Verify that both of the Connected and Connect at power on check boxes are selected and click OK. 

4 Select Network adaptor 2 and under Network Connection, select the Network label option, and select the 
relevant promiscuous port group.

5 Verify that both of the Connected and Connect at power on check boxes are selected and click OK.

6 (Optional) Delete the temporary vSwitch.
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Configure AppSpeed to Monitor Cisco Nexus 1000V Switches

This section details the processes you must follow to monitor Nexus 1000V switches,

To deploy a probe, at least one Nexus wi1000V switch must be available on the ESX serverhost for the probe 
to monitor. If the host does not have any switches configured, or if all other switches are already being 
monitored by other probes, you must create a new temporary vSwitch before you deploy the new probe. 
See “Create a Temporary vSwitch” on page 21.

Install a probe on a Cisco Nexus 1000V Switch

You can install a probe on one host at a time, or you can install a probe on multiple hosts at the same time.

Procedure

1 In the vSphere Client, select Home. On the Solutions and Applications tab, click the AppSpeed icon.

2 (Optional) If the name displayed in the Connect to text box is incorrect or the AppSpeed Server name is 
not in the list, type the correct namespace.

3 (Optional) If the AppSpeed icon does not appear, verify that the AppSpeed plug-in is enabled in the 
Plug-ins menu.

4 Click the Administration tab and select Probes Management.

5 Select the check boxes for one or more hosts or clusters on which to install a probe and click the Install 
Probes button.

A probe is installed on each selected host, regardless of whether another probe is already installed on the host.

When you select the check box for a cluster, the check boxes for each host that it contains are selected. 
Similarly, when you select a host, the probes already installed on it are selected.

The Probe Installation window displays a separate entry for each host that you select. Each entry appears 
in a separate pane. 

6 Click the Install Probes button.

7 Review the installation information, and click OK.

Alternatively, click Back to return to change any of the settings.

The installation progress is indicated in the Probe Status column in the Probes Management window.

Upon completion, the new probe is added to the <namespace> Probes folder in the vSphere Client. The 
probe is powered on and set up. 

8 Delete the AppSpeed Server virtual machine snapshot after you finish deploying all the probes.

Configure the AppSpeed Probe to Monitor a Cisco Nexus 1000V Switch

After the probe is deployed and set up, you can configure AppSpeed to monitor a Nexus 1000V switch.

Procedure

1 In the vSphere Client, select Home. On the Inventory tab, select Hosts and Clusters.

2 In the Inventory tree, right-click the probe in the Nexus 1000V and select Edit Settings.

3 Select the required network adapter. 

4 From the Network Connections menu, select the relevant Nexus port group.

5 Verify that both the Connected and Connect at power on check boxes are selected and click OK. 
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Configure Port Mirroring

You must configure port mirroring on the Cisco Nexus 1000V vSwitch ports so that the AppSpeed probe can 
monitor a Nexus 1000V vSwitch. For further information, refer to the Cisco documentation.

Procedure

1 On The Cisco Nexus 1000V vSwitch, specify the server port to which Network adaptor 2 is connected, to 
monitor as the source ports.

2 On the Cisco Visual Switch Manager, identify the interface on which the AppSpeed probe was added to 
the port group (for example, Vethernet1) and specify that interface as the destination port.

3 (Optional) To add the management network to the distributed vSwitch, select Network adapter 1. 

a Under Network Connection, select the Network label option, and select the relevant distributed 
virtual port group, by default, dvPortgroupX.

b Verify that both of the Connected and Connect at power on check boxes are selected and click OK. 

Creating and Deploying Temporary vSwitches

This section details the procedures that you must follow when you need to create temporary vSwitches, for 
example when no legacy switches are available for the AppSpeed probe to monitor. After a probe has been 
deployed, VMware recommends that you delete the temporary switch.

Create a Temporary vSwitch

To deploy a probe, at least one vSwitch must be available on the host for the probe to monitor. If the host does 
not have any vSwitches configured, or if all other vSwitches are already being monitored by other probes, you 
must create a new temporary vSwitch before you deploy the new probe. If an available vSwitch exists on the 
host, you do not need to create a temporary switch.

Procedure

1 In the vSphere Client, select Home. On the Inventory tab, select Hosts and Clusters.

2 Select the destination host on which to install the probe.

3 Select Configuration > Networking, and in the Virtual Switch view, select Add Networking Wizard.

4 In the Connection Type window, select the Virtual Machine option and click Next.

5 Select the create a virtual switch option, ensure that none of the check boxes for the NICs are selected, and 
click Next.

6 Type a name for the vSwitch in the Network label text box and click Next.

7 Click Finish.

Deploy a Probe on a Temporary vSwitch

After you have created a temporary switch because there were not any available vSwitches on the host, you 
can deploy a probe on it.

Procedure

1 In the vSphere Client, select Home. On the Inventory tab, select AppSpeed.

2 Click the Administration tab and select Probes Management.

3 Select the check box for the host on which you installed the temporary vSwitch, and click the Install 
Probes button.

The Probe Installation dialog box appears.

4 Type the name of the probe in the Probe Name text box. 

If you do not specify a name, AppSpeed Server assigns a default name.

5 From the Storage menu, select the storage device to which the probe connects.
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6 From the Management Network menu, select the network to use to manage the probes.

a Select the check boxes of up to three monitoring vSwitches.

The vSwitches sniff traffic on the configured management network. 

By default, the first three available vSwitches are selected.

b Select either the DHCP or Static IP option. 

If you select Static IP, you must type values for each of the IP, Network, and Gateway (optional) 
fields.

7 Click Install Probes.

8 Review the installation summary and click OK.

NOTE   If your management network was set to a temporary vSwitch and the probe failed to communicate 
with AppSpeed Server, an error message appears when the probe deployment completes. The issue is 
resolved when you perform the following steps, however the error message might continue to appear as 
failed in the user interface.

a Right-click the probe name, select Edit Settings and specify the management network and monitor 
network settings as required. For further information, see step 3 in “Configure the AppSpeed Probe 
to Monitor a Cisco Nexus 1000V Switch.”

b Restart the probe by selecting the probe in the Inventory tree, and pressing CTRL+R.

9 (Optional) Delete the temporary vSwitch.

Multiple AppSpeed Servers
You can centrally manage AppSpeed through a single user interface when more than one AppSpeed Server is 
installed.

Select a Server and Switch Between Servers

When you activate AppSpeed from the vSphere client with more than one AppSpeed Server installed, you are 
redirected to a selection screen where you can select which server to connect to. 

Procedure

1 Click the Switch Server link at the top right of the page. 

2 In the selection screen, type the namespace of the server to which you want to switch. 

Limitations when You Use Multiple Servers

The following limitations apply when using multiple servers.

 No central license management exists.

 You can apply the license key to multiple AppSpeed Servers, as long as the actual number of 
monitored CPUs does not exceed the number of CPUs defined in your license.

 The same virtual machine might be monitored by two or more different AppSpeed Servers. As a 
result, the licenses are counted twice, once on each server. Nevertheless, only the actual number of 
CPUs that are being monitored are relevant to your AppSpeed license. 

 Topology and monitoring information is not shared between the servers. The same application can be 
mapped in two or more servers. The monitoring data in the two servers might be different because the 
two servers might detect different traffic. Changes in the configuration of the application, such as names 
and thresholds, in one server are not reflected in the other. 

 One AppSpeed Server can map the management traffic of a different AppSpeed Server as an application. 
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 When you use the vSphere Client, you cannot connect to AppSpeed Servers that are located on different 
vCenter Servers in a linked vCenter Server environment. You must use the vSphere Client to log in to each 
vCenter Server on which AppSpeed Servers are located.

Extracting SSL Files
You can extract the SSL files from the Web server to obtain the SSL keys. The extraction procedure varies 
according to the type of Web server. Following the extraction, you can upload the key file to AppSpeed Server, 
as described in “Add an SSL Key” on page 17.

Extract SSL Files from an Apache Server

You can extract the SSL files from an Apache server.

Procedure

1 In the Apache conf directory, open the http.conf file. 

The filename is commonly /etc/httpd/conf.d/ssl.conf or /etc/httpd/conf/httpd.conf.

2 Locate the SSLCertificateKeyFile command on the SSL site.

3 Save a copy of the file that appears under SSLCertificateKeyFile as [cluster].key and transfer it 
to the vSphere Client machine.

Extract SSL Files from a Microsoft IIS 6.0 Server

You can extract the SSL files from a Microsoft IIS 6.0 server. Files are extracted by exporting the IIS key file. 
Following the extraction, you can transfer the PFX file to the vSphere Client machine and upload it to 
AppSpeed Server, as described in “Add an SSL Key” on page 17.

Procedure

1 Select Start > Programs > Administrative Tools > Internet Information System (IIS) Manager.

2 Expand the COMPUTERNAME (local computer) tree in the left pane, then expand the Web Site tree.

3 Right-click Default Web Site and select Properties.

4 Select the Directory Security tab, then select the Server Certificate button.

5 Select Next, select Export the current certificate to a PFX file, and select Next again.

6 Select a file to which the exported certificate and key will be written, and select Next.

7 Type the password with which the key is to be encrypted.

During the export process, a password is requested to protect the key. If a password is assigned, note the 
password. It is required when you import the key into AppSpeed.

8 Re-type the password in the Confirm Password text box and click Finish.

Extract SSL Files from a Microsoft IIS 7.0 Server

You can extract the SSL files from a Microsoft IIS 7.0 server. Files are extracted by exporting the IIS key file. 
Following the extraction, you can transfer the PFX file to the vSphere Client machine and upload it to 
AppSpeed Server, as described in “Add an SSL Key” on page 17.

Procedure

1 Select Start Programs > Administrative Tools > Internet Information System (IIS) Manager. 

2 Expand the COMPUTERNAME (local computer) tree in the left pane and double-click the Server 
Certificates icon in the middle pane.

3 Right-click the certificate and select Export. 

A PFX file is created. 
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During the export process, a password is requested to protect the key. If a password is assigned, note the 
password. It is required when you import the key into AppSpeed.

Upgrading AppSpeed
If a new version of AppSpeed is available, you can upgrade to that version.

Overview of the Upgrade Process

The AppSpeed upgrade process uses an ISO image and is fully automated. VMware provides the ISO image.

You upgrade AppSpeed by connecting the ISO image with the new version to the AppSpeed Server virtual 
machine and running a command-line interface (CLI) command. The CLI command performs the following 
actions:

1 Upgrades AppSpeed Server and performs two sequential reboots.

2 Sets up AppSpeed Server with the new version, keeping all configurations and monitoring data of the 
previous version.

3 Creates a recovery virtual machine snapshot of the AppSpeed Server virtual machine, to which you can 
revert at any time.

4 Creates a backup copy of all of the configuration and monitoring data to enable the upgrade to restore 
existing data.

5 Distributes the upgraded version to all probes.

You can observe the progress of the AppSpeed Server upgrade and setup processes from the console. You can 
observe the redeployment of the probes in the AppSpeed user interface.

Upgrade AppSpeed

You upgrade AppSpeed version using the ISO image that VMware provides. The upgrade process reboots 
AppSpeed Server and recreates all AppSpeed probes. This might take some time.

Procedure

1 Save the ISO file to a location on your local disk. 

2 In the vSphere Client, connect AppSpeed Server to the ISO file.

a Select the AppSpeed Server virtual machine in the inventory tree.

b Click the Connect CD/DVD devices icon and select Connect to ISO image on local disk from the 
menu. 

c Browse to the location of the ISO file. 

3 Log in to the AppSpeed Server console as the console user.

4 From the default console shell, run the command upgrade_AppSpeed.

5 Press Enter to run the upgrade script.

After AppSpeed Server boots from the ISO image, it continues the upgrade process, including rebooting 
and recreating the probes. This process can take up to one hour. 

A message appears when the AppSpeed Server upgrade is complete. 

6 When prompted, disconnect the ISO file in the Client.

The probes are recreated in the new version. You can monitor the redeployment process from the 
AppSpeed Probes Deployment window. 

After the upgrade is complete, verify the redeployment of the probes, as described in “Verify the Installation” 
on page 15.
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Uninstalling AppSpeed and Removing the AppSpeed Plug-In
To completely remove AppSpeed from your system, you must delete AppSpeed probes, uninstall AppSpeed, 
remove the AppSpeed plug-in from the available plug-ins list and from the vSphere Client, and remove 
AppSpeed users.

Procedure

1 Click the Administration tab, and in the Management Tools pane click Probes Management. 

2 Delete all probes by selecting the check boxes and clicking Delete Probe.

If some probes remain, delete them from the vSphere Client,

a Power off the virtual machine.

b Right-click the machine name and select Delete from Disk.

3 Delete the promiscuous port groups created by AppSpeed as part of probe deployment,

a In the vSphere Client, select a host that has a probe installed, click the Configuration tab, and click 
the Networking link.

b For each vSwitch, identify and delete any port groups called vSwitchn AppSpeed, where n is a 
unique number for the vSwitch name.

c Repeat this process for each host on which a probe is installed.

4 In the vSphere Client, click Home > Inventory > VMs and Templates and delete the <namespace> 
Probes folder from each datacenter in which it exists.

5 Disable the AppSpeed plug-in from the available plug-in list.

a Connect to your vCenter Extension Manager from the browser at 
https://<Virtual_Center_IP>/mob/?moid=ExtensionManager.

b Select Unregister Extension.

c Copy the following string into the value text box:
com.vmware.cde.sdk.<namespace>.cliext.<namespace>

d Select the Invoke method.

e Restart the vSphere Client.

6 Delete the virtual machine on which AppSpeed Server was deployed from the vSphere Client.

a Power off the virtual machine.

b Right-click the machine name and select Delete from Disk.

7 Click Home > Administration > Roles and remove AppSpeed User privileges, and the AppSpeed User 
role.

8 On your client machine, click Start > Settings > Control Panel > Add or Remove Programs and delete 
VMWare AppSpeed plugin for VI Client.
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Troubleshooting
If you encounter problems when using AppSpeed, use this troubleshooting information. 

AppSpeed Setup Errors

You might have problems while setting up AppSpeed.

Failed to Register AppSpeed with vCenter Server

Problem  

Setup fails and the following error message appears: 

Failed to register AppSpeed with vCenter Server: Unable to find AppSpeed Server on the 
configured vCenter Server.

Cause 

You entered the IP address of a vCenter Server that is not the server on which AppSpeed was installed. 

Solution

1 Verify the accuracy of the vCenter Server IP address.

2 Run setup again and enter the correct IP address.

vCenter Server HTTPS Web Service Port Does Not Work With Port 443

Problem  

Setup fails and the following error message appears: 

Connection timed out. Verify the vCenter address and try again.

Cause

The vCenter Server HTTPS Web Service port is not configured to work with the default port 443.

Solution

1 Check the vCenter ServerWeb Service port. 

2 Run setup again and enter <vCenter_IP>:<HTTPS_Port> in the vCenter parameters section.

vCenter Server HTTPS Web Service Port Traffic Is Blocked

Problem

Setup fails and the following error message appears: 

Connection timed out. Verify the vCenter address and try again.

Cause

The vCenter Server HTTPS Web Service port is blocked to traffic between the AppSpeed Server and 
vCenter Server.
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Solution

1 Verify with IT that the vCenter Server HTTPS Web Service port on the firewall is open between the 
AppSpeed Server and vCenter Server.

2 Run setup again.

3 If the problem persists, 

a Log in to the AppSpeed Server virtual machine as the console user and run shell. 

b Telnet to the vCenter Server IP with the vCenter Server HTTPS Web Service configured to port 443 to 
verify that the port is open.

Server Unavailable Because Firewall Closed for Port 80

Problem

The following error message appears:

The remote server returned an error: Server Unavailable

Cause

The vSphere Client uses HTTP to download the AppSpeed user interface from AppSpeed Server. If the firewall 
between the vSphere Client and AppSpeed Server is closed for port 80, the download fails. 

Solution

1 Open a Web browser and go to http://<AppSpeed_IP>/static/setup.exe to verify that port 80 is open on the 
firewall.

2 Go to http://<vCenter_IP>:<port>/<AppSpeed_namespace>/static/setup.exe to verify that redirection 
through the vCenter Server is working correctly.

3 If the problem persists, log in to the AppSpeed Server virtual machine as the console user and run the 
restart_AppSpeed command.

AppSpeed User Interface Loading Problems

You might have problems loading the AppSpeed user interface.

Error 404

Problem

After you click the AppSpeed plug-in Download and Install link, the following message appears: 

The remote server returned an error: (404) Not Found.

Cause

The AppSpeed plug-in fails to install if the vCenter Server is not configured to work with port 80.

Solution

1 Manually download the setup.exe file from 
http://<vCenter_IP>:<HTTPS_Port>/<namespace>/static/setup.exe 

2 Run the setup.exe file. 

Close the vSphere Client before you perform the installation.

3 On the machine that is running the vSphere Client, go to C:\Program 
Files\VMware\Infrastructure\Virtual Infrastructure Client\Plugins\AppSpeed. 

4 Open the Settings.config file in a text editor.
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5 Replace the line <!--Port>80</Port--> with the line <Port>HTTP_Port</Port>.

For example, for a vCenter Server configured with port 8080, use <Port>8080</Port>.

6 Save and close the file.

7 Restart the vSphere Client and enable the AppSpeed plug-in on the Plugin tab.

AppSpeed View Does Not Load

Problem

Clicking the AppSpeed icon in the vSphere Client does not load the AppSpeed view. 

Cause 

A connection to the server cannot be established or proxy settings are incorrect. This type of error is usually 
preceded by one of the following messages: Received a connectivity error or URL Error received.

Solution

1 Verify with IT that port 80 is open on the firewall.

2 Restart the vSphere Client.

3 Wait a few minutes for the AppSpeed user interface to load.

4 If the user interface still does not load, reinstall the user interface from the plug-in window.

See “Install the AppSpeed Plug-In” on page 11.

Unable to Communicate with AppSpeed Server

Problem

The following error appears in the user interface:

Unable to communicate with AppSpeed server: failed to download UI module from 
http://<vCenter address>/AppSpeed>, consult your system administrator.

Cause

An HTTP connection to AppSpeed Server is refused due to certificate authorization issues. 

Solution 

1 In an Internet browser, go to http://<AppSpeed Server IP>. 

A message might appear indicating that the server’s certificate must be approved before the machine 
allows HTTP connections. 

2 Approve the certificate using the Web browser. 

3 Restart the vSphere Client.

4 Click the AppSpeed button. 

5 If the problem persists, go to http://<AppSpeed Server IP>/<namespace>/static/setup.exe and download 
setup.exe from AppSpeed Server. 

If you succeed, the server is accessible. 

6 If the problem persists and the 503 Service Unavailable message appears, log in to the AppSpeed 
Server virtual machine as the console user and run restart_AppSpeed from the console.

NOTE   You do not have to uninstall the user interface before reinstallation.
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Unable to Connect to AppSpeed

Problem

The user interface cannot connect to AppSpeed. 

Cause

Storage used by AppSpeed Server was disconnected for a while causing the file system to respond as a 
read-only file system.

Verify the cause by logging into the console on the AppSpeed virtual machine and running commands such 
as start_AppSpeed or restart_AppSpeed. The resulting error message will indicate that the file system is 
read-only. For example, a message similar to the following one might appear, OS Error: [Error 30] 
Read-only file system: 'twistd.pid’

Solution

1 Validate that the storage is running.

2 From the vSphere Client, reboot the AppSpeed Server’s virtual machine to reinitialize the file system.
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